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All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, 
stored on a retrieval system or translated into any language, in any form or by any means, 
electronic, mechanical, manual or otherwise, without the prior consent of NuVant Systems, Inc. 
NuVant Systems, Inc. makes no representations or warranties with respect to the contents hereof 
and specifically disclaims any implied warranties of merchantability and fitness for a particular 
purpose. Furthermore, NuVant Systems, Inc. reserves the right to revise this publication and to 
make changes from time to time in the content hereof without obligation to notify any person of 
such revision or changes.  
 
 

Program License Agreement  
 

Do not use the software package until you have read the license agreement. If you use the 
program, NuVant Systems will assume that you have agreed to, and as such are, bound by this 
standard agreement. If you do not accept the terms of this license, you must return the package 
unused to the party from whom you received it. The program contained in this package is 
provided to the end user as a single program for use on a single machine and not for distribution 
to other machines or parties.  
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The EZware Software package is an executable that controls all models 
of NuVant potentiostat/galvanostats and bipotentiostats and some of the 
multichannel potentiostats.  Variations due to specific instrument models 

are clarified within the manual. 
 
 
 
 
 
 

  



EZware Operating Manual 
 
 

  4 
NuVant Systems Inc.  Release - 4.0 
 

GLOSSARY........................................................................................................................................... 7 

Abbreviations for Step Impedance Spectroscopy (SIS) ........................................................................ 7 

INSTRUMENT SPECIFICATIONS .................................................................................................... 8 

EZstat-Pro and Powerstat vs. EZstat-Basic and Basic 8........................................................................ 8 

On-Board Function Generator vs. CPU Timing ................................................................................... 8 

EZstat-Pro ........................................................................................................................................... 9 

EZstat-Pro LC ................................................................................................................................... 10 

EZstat-Pro EIS .................................................................................................................................. 11 

EZstat-Basic ...................................................................................................................................... 13 

EZstat-Basic LC ................................................................................................................................ 15 

Multichannel Potentiostat .................................................................................................................. 16 

1.1.1. EZstat-Basic 8 ..................................................................................................................... 16 

Powerstat-05 ..................................................................................................................................... 17 

Powerstat-20 ..................................................................................................................................... 18 

Powerstat-05E (16 bit) ....................................................................................................................... 20 

Powerstat-05E (18 bit) ....................................................................................................................... 21 

EZstat Mains Supply Input Specifications.......................................................................................... 22 

EZstat Mains Power Cable Manufacturer Data .................................................................................. 22 

Powerstat Mains Supply Input Specifications .................................................................................... 23 

Powerstat Mains Power Cable Manufacturer Data ............................................................................. 23 

Overall Dimensions and Weight ........................................................................................................ 24 

INTENDED USE OF EQUIPMENT .................................................................................................. 25 

SAFETY .............................................................................................................................................. 26 

General ............................................................................................................................................. 26 

Computer Control and System Safety ................................................................................................ 26 

Grounding ......................................................................................................................................... 27 

ESD Protection ................................................................................................................................. 27 

AC Supply Voltage ........................................................................................................................... 27 

Placement and Surroundings of the EZstat and Powerstat .................................................................. 28 

Normal Environmental Conditions for EZstat and Powerstat ............................................................. 28 

Accessory Cables .............................................................................................................................. 29 

Technical Assistance Contact Information ......................................................................................... 29 

HARDWARE CONVENTIONS ......................................................................................................... 30 



EZware Operating Manual 
 
 

  5 
NuVant Systems Inc.  Release - 4.0 
 

HARDWARE INSTALLATION ........................................................................................................ 30 

Description of Controls and Connections ........................................................................................... 30 

EZstat Front Panel ............................................................................................................................. 30 

Powerstat Front Panel ........................................................................................................................ 31 

Procedure for Connection of Electrode Cables to an Electrochemical Device ..................................... 35 

EZstat Back Panel ............................................................................................................................. 36 

Powerstat Back Panel ........................................................................................................................ 38 

CLEANING AND MAINTENANCE ................................................................................................. 39 

SERVICE AND REPAIR .................................................................................................................... 39 

SOFTWARE INSTALLATION ......................................................................................................... 40 

SOFTWARE AND INSTRUMENT STARTUP ................................................................................. 41 

RECIPE DESIGN ............................................................................................................................... 46 

General Recipe Notes ........................................................................................................................ 46 

Cyclic Voltammetry .......................................................................................................................... 46 

Linear Sweep Voltammetry ............................................................................................................... 48 

Multi Vertex Waveform .................................................................................................................... 49 

Programmable Potential Waveform – Hold/Ramp/Step ...................................................................... 54 

Battery Cycling ................................................................................................................................. 58 

Differential Pulse Voltammetry ......................................................................................................... 59 

Normal Pulse Voltammetry ............................................................................................................... 60 

Step Impedance Spectroscopy (SIS) .................................................................................................. 61 

Electrical Impedance Spectroscopy (EIS) .......................................................................................... 62 

STOPPING / RESTARTING AND EXPERIMENT .......................................................................... 64 

SAMPLE EXPERIMENTS ................................................................................................................. 65 

Linear Voltammetry – Corrosion Experiment .................................................................................... 65 

Cyclic Voltammetry (5mM K4Fe(CN)6 and K3Fe(CN)6 in 1M KNO3) ................................................ 69 

Step Impedance Spectroscopy (3.78V Li ion battery) ......................................................................... 72 

DATA VISUALIZATION AND ANALYSIS ..................................................................................... 76 

Axes Rescaling ................................................................................................................................. 76 

Saving Data ....................................................................................................................................... 79 

Data Analysis – Area Calculations ..................................................................................................... 81 



EZware Operating Manual 
 
 

  6 
NuVant Systems Inc.  Release - 4.0 
 

Data Analysis – SIS .......................................................................................................................... 90 

Filters ................................................................................................................................................ 94 

Overlaying Data ................................................................................................................................ 97 

Data Analysis – Tafel Plot ................................................................................................................. 98 

TROUBLESHOOTING INFORMATION ....................................................................................... 103 

APPENDIX ........................................................................................................................................ 105 

 

  



EZware Operating Manual 
 
 

  7 
NuVant Systems Inc.  Release - 4.0 
 

GLOSSARY 
 
Listed below are the symbols used to identify windows and actions in the EZware software. 

 SYMBOL WINDOW/ACTION EXAMPLE 

[Square brackets] Window [Edit Single Method] 

Bold Button press Last Run Data 

Bold underline Experiment recipe header Linear Sweep Voltammetry 

Underline End-user input Pretreatment Time [s] 

“Quotes” End-user input options “10” 

Bold→Italics→Plain text Menu header→1st menu 
selection→2nd menu selection 

Technique→Sweep Techniques→Linear Sweep 
Voltammetry 

 

Abbreviations for Step Impedance Spectroscopy (SIS) 
SIS Impedance Calculator 

Rs Solution resistance 

Rct Charge transfer resistance 

Cdl Double layer capacitance 

So (1/Zw)*t  

E Open circuit voltage 

Q Charge transferred during pulse 

dE/dQ*  Charge derivative of  E 

  *Q(coulombs) 

  

SIS Theory 
t0 Beginning of the 

pretreatment period 
tp,i Pulse initiation time 

tp,f Pulse final time 

tr,f End of relaxation time 

tpw = tpf  - tpi  Pulse width 

trp = trf  - tpf Relaxation period 

E(t) =  Eeq1 For ( tp,i - tinterv ≤ t ≤ tp,i ) 

Eeq2 ∼E(tr,f  ) 

T RC time constant 
specific to differential 
equation 

ip Pulse amplitude 

tinterv Sampling interval time 
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INSTRUMENT SPECIFICATIONS 
 

EZstat-Pro and Powerstat vs. EZstat-Basic and Basic 8 
 
 The EZstat-Pro and Powerstat series have a built-in function generator that enables high speed 
scans and a buffer that permits high rate data collection.  Thus the EZstat-Pro and Powerstat 
series perform a number of advanced functions that the EZstat-Basic and EZstat-Basic 8 cannot.  
The functions that the EZstat-Basic and EZstat-Basic 8 cannot perform are grayed out in the 
EZstat-Basic and EZstat-Basic 8 software.   
 
The EZstat-Pro and Powerstat series have a 16 bit AO control and AI data acquisition system.  
The EZstat-Basic and EZstat-Basic 8 have a 12 bit AO control and 14 bit AI data acquisition 
system. 
 

 

On-Board Function Generator vs. CPU Timing  
 
Only the EZstat-Pro and Powerstat series utilize a high-precision, hardware-timed function 
generator.  The EZstat-Basic and EZstat-Basic 8 are limited to the CPU-timed function 
generator. Consequently, the output wave-form update sampling rate is limited to 100S/s (150S/s 
in turbo mode) for the EZstat-Basic and Basic 8. The timing precision for EZstat-Basic and 
EZstat-Basic 8 depends on the computer hardware and the load on the CPU. Typically the 
precision is within 2ms. 
 
Due to the limitations in the data acquisition hardware for the EZstat-Basic and EZstat-Basic 8, it 
is recommended not to perform experiments while also running other operations that demand 
high CPU usage.  This will improve the timing accuracy in the output data update and prevent 
deviations in timing. 
 
 
 
 

The following instrument specifications are for instruments purchased after  
October 1st, 2013.  Specifications for older instruments can be found in the 

appendix. 
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EZstat-Pro 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery cycling, 

Step Impedance Spectroscopy with Analysis 

Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A) 

Best Applied Current Resolution 3 nA, 0.003% of FSR 

Applied Current Accuracy 0.03% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GW parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate 500 V/s 

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3 µV, 300 µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

Current Measurement   

Measured Current Ranges GalvanoSTAT: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

PotentioSTAT: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A ) 

PotentioSTAT Min to Max 3 nA to 1 A 

 Best Resolution GalvanoSTAT: 3 nA (0.003% of FSR)                                                        

PotentioSTAT: 610 pA - 340 µA (0.06 - 0.003% of FSR In 

Order of Range) 

Accuracy GalvanoSTAT: 0.03% of FSR;                                                

PotentioSTAT: 0.3 - 0.03% of FSR Depending on Range 

  

Data Acquisition   

Acquisition Speed 250 k samples/s (Aggregate)                                                    

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 

FSR: Full Scale Range  
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EZstat-Pro LC 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling 

Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±10 mA 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA)    

Best Applied Current Resolution 40 pA, 0.004% of FSR 

Applied Current Accuracy 0.04% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GW parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate 100 V/s 

IR Compensation None, Low Current Device 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3 µV, 300 µV  (0.006%, 0.003% of Full Scale Range) 

Accuracy 0.08 or 0.03% of Full Scale Range   

Current Measurement   

Measured Current Ranges GalvanoSTAT: 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA)                                                        

PotentioSTAT: 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA) 

PotentioSTAT Min to Max 3 nA to 10 mA 

 Best Resolution GalvanoSTAT: 40 pA (0.004% of Full Scale Range)                                                        

PotentioSTAT: 40 pA (0.004% of Full Scale Range) 

3 s Coverage Factor Accuracy GalvanoSTAT: 0.04% of Full Scale Range                                   

PotentioSTAT: 0.04% of Full Scale Range 

Data Acquisition   

Acquisition Speed 250 k samples/s (Aggregate)                                                            

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 
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EZstat-Pro EIS 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling, EIS with Analysis 

Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Potentiostat Slew Rate 0.2 V/µs 

Bandwidth 10 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A) 

Best Applied Current Resolution 3 nA, 0.003% of FSR 

Applied Current Accuracy 0.03% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate Potentiostat 500 V/s 

Current raise rate Galvanostat >64 A/ms 

IR Compensation Manual, Potentiostat Mode 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3 µV, 300 µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

Current Measurement   

Measured Current Ranges 
GalvanoSTAT: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

PotentioSTAT: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A ) 

PotentioSTAT Min to Max 3 nA to 1 A 

 Best Resolution 
GalvanoSTAT: 3 nA (0.003% of FSR)                                                        

PotentioSTAT: 610 pA - 340 µA (0.06 - 0.003% of FSR In 

Order of Range) 

Accuracy 
GalvanoSTAT: 0.03% of FSR;                                                

PotentioSTAT: 0.3 - 0.03% of FSR Depending on Range 

EIS Measurement   

Frequency Range 10mHz - 10kHz 

Max AC amplitude 200mV 

AC Applied Potential Resolution 6µV 
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Min AC amplitude 60µV 

Data Acquisition   

Acquisition Speed 
250 k samples/s (Aggregate)                                                            

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 

FSR: Full Scale Range 
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EZstat-Basic  

 
 

Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling

Cell Control

Compliance Voltage ±25 V

Max Output Current ±1 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.2 V/µs

Bandwidth 8 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±2.5 V)

Applied Potential Resolution 7 mV

Applied Potential Accuracy < 0.4% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A)

Best Applied Current Resolution 60 nA, 0.06% of FSR

Applied Current Accuracy 0.35% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pF

Maximum Update Rate 100 ms

Maximum Scan Rate 1 V/s

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range

External Control None

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V)

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR)

Accuracy 0.15% or 0.08% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, )

Potentiostat Min to Max 15 nA to 1 A

Best Resolution

Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range)

Accuracy
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range

Data Acquisition

Acquisition Time 100 µs

Acquisition Speed 10,000 samples/second

DAC Resolution 14 bit

FSR: Full Scale Range



EZware Operating Manual 
 
 

  14 
NuVant Systems Inc.  Release - 4.0 
 

EZstat-Basic +5 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling 

Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (0 ÷ 5 V) 

Applied Potential Resolution 1.2 mV 

Applied Potential Accuracy < 0.4% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A) 

Best Applied Current Resolution 60 nA, 0.06% of FSR 

Applied Current Accuracy 0.35% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 100 ms 

Maximum Scan Rate 0.1 V/s 

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range 

External Control None 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) 

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR) 

Accuracy 0.15% or 0.08% of FSR 

Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, ) 

Potentiostat Min to Max 15 nA to 1 A 

Best Resolution 
Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range) 

Accuracy 
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range 

Data Acquisition   

Acquisition Time 100 µs 

Acquisition Speed 10,000 samples/second 

DAC Resolution 14 bit 

FSR: Full Scale Range 
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EZstat-Basic LC 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery cycling 

Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±2.5 V) 

Applied Potential Resolution 1.2 mV 

Applied Potential Accuracy < 0.4% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±1 µA, ±10 µA, ±100 µA, ±10 mA) 

Best Applied Current Resolution 60 nA, 0.06% of FSR 

Applied Current Accuracy 0.35% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 100 ms 

Maximum Scan Rate 0.1 V/s 

IR Compensation NA 

External Control None 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) 

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR) 

Accuracy 0.15% or 0.08% of FSR 

Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±1 µA, ±1 µA, ±10 µA, ±10 mA)                                                        

Potentiostat: 4 ((±1 µA, ±1 µA, ±10 µA, ±10 mA ) 

Potentiostat Min to Max 3 nA to 10 mA 

Best Resolution Galvanostat: 40 pA (0.01% of FSR)                                                        

Potentiostat: 40 pA (0.24 - 0.013 % of FSR In Order of Range) 

3 s Coverage Factor Accuracy 
Galvanostat: 0.04% of Full Scale Range                                   

Potentiostat: 0.04% of Full Scale Range 

Data Acquisition   

Acquisition Time 100 µs 

Acquisition Speed 10,000 samples/second 

DAC Resolution 14 bit 

FSR: Full Scale Range  
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Multichannel Potentiostat 

1.1.1. EZstat-Basic 8 
Comes in a single chassis with the power supply enclosed and requires dual monitors and a 
computer to be configured by NuVant Systems.  All 8 channels are entirely independent.

Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling

Cell Control

Compliance Voltage ±15 V

Max Output Current ±1 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.2 V/µs

Bandwidth 8 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±2.5 V)

Applied Potential Resolution 7 mV

Applied Potential Accuracy < 0.4% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A)

Best Applied Current Resolution 60 nA, 0.06% of FSR

Applied Current Accuracy 0.35% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pF

Maximum Update Rate 100 ms

Maximum Scan Rate 1 V/s

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V)

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR)

Accuracy 0.15% or 0.08% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, )

Potentiostat Min to Max 15 nA to 1 A

Best Resolution

Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range)

Accuracy
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range

Data Acquisition

Acquisition Time 100 µs

Acquisition Speed 10,000 samples/second

DAC Resolution 14 bit

FSR: Full Scale Range
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Powerstat-05 

Features 
Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling, Step Impedance Spectroscopy with Analysis 

Cell Control   

Compliance Voltage  ±15 V 

Max Output Current ±5 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.8 V/µs 

Bandwidth 6 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 mA, ±1 A, ±3 A, ±5 A) 

Best Applied Current Resolution 3 µA, 0.003% of FSR 

Applied Current Accuracy 0.03% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate 100 V/s 

IR Compensation Manual, Potentiostat and Galvanostat Modes, All Ranges 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3µV, 300µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

Current Measurement   

Measured Current Ranges 
GalvanoSTAT: 4 (±100 mA, ±1 A, ±3 A, ±5 A)                                                        

PotentioSTAT: 4 (±100 mA, ±1 A, ±3 A, ±5 A)   

PotentioSTAT Min to Max 1 mA to 5 A 

 Best Resolution 
GalvanoSTAT: 3 µA (0.003% of FSR)                                                        

PotentioSTAT: 3 µA (0.003% of FSR) 

Accuracy 
GalvanoSTAT: 0.03% of FSR                                       

PotentioSTAT: 0.03% of FSR 

  Data Acquisition   

Acquisition Speed 
250 k samples/s (Aggregate)                                                            

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 

FSR: Full Scale Range 
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Powerstat-20 

Features 
Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling, Step Impedance Spectroscopy with Analysis 

Cell Control   

Compliance Voltage ±10 V 

Max Output Current ±18 A 

Rise Time 60 us for 0.2 Ohm load (0%-100% signal)  

Slew Rate 0.8 V/µs 

Bandwidth 6 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 mA, ±0.8 A, ±3 A, ±18 A) 

Applied Current Resolution by Range 

±100 mA: 15 µA (0.015% of FSR),                                                                                  

±0.8 A: 53 µA (0.0067% of FSR),                                                                              

±3 A: 0.12 mA (0.0039% of FSR),                                                                        

±18 A: 0.56 mA (0.0031% of FSR) 

Applied Current Accuracy by Range 

±100 mA: 0.10% of FSR,                                                                                  

±0.8 A: 0.053% of FSR,                                                                                     

±3 A: 0.037% of FSR,                                                                          

±18 A: 0.033% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate 100 V/s 

IR Compensation Manual, Potentiostat and Galvanostat Modes, All Ranges 

External Control 1 AO, 1 AI, 2 DO 

  Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3µV, 300µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

  Current Measurement   

Measured Current Ranges 
GalvanoSTAT: 4 (±100 mA, ±0.8 A, ±3 A, ±18 A)                                                        

PotentioSTAT: 4 (±100 mA, ±0.8 A, ±3 A, ±18 A)   

PotentioSTAT Min to Max 1 mA to 18 A 
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 Resolution by Range 

PotentioSTAT and GalvanoSTAT are the same                                                                     

±100 mA: 15 µA (0.015% of FSR),                                                                                  

±0.8 A: 53 µA (0.0067% of FSR),                                                                              

±3 A: 0.12 mA (0.0039% of FSR),                                                                        

±18 A: 0.56 mA (0.0031% of FSR) 

Accuracy 

PotentioSTAT and GalvanoSTAT are the same                                                                     

±100 mA: 0.095% of FSR,                                                                                  

±0.8 A: 0.050% of FSR,                                                                              

±3 A: 0.035% of FSR,                                                                         

±18 A: 0.031% of FSR 

  Data Acquisition   

Acquisition Speed 
250 k samples/s (Aggregate)                                                            

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 

FSR: Full Scale Range 
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Powerstat-05E (16 bit) 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery 

cycling, EIS with Analysis 

Cell Control   

Compliance Voltage  ±15 V 

Max Output Current ±5 A 

Rise Time 25 µs for 1 Ω load (0%-100% signal)  

Slew Rate 0.8 V/µs 

Bandwidth 10 kHz (-3 dB, 1 Ω load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 mA, ±1 A, ±3 A, ±5 A) 

Best Applied Current Resolution 3 µA, 0.003% of FSR 

Applied Current Accuracy 0.03% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 1.2 µs 

Maximum Scan Rate 100 V/s 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3µV, 300µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)                                                        

Potentiostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)   

Potentiostat Min to Max .1 mA to 5 A 

 Best Resolution 
Galvanostat: 3 µA (0.003% of FSR)                                                        

Potentiostat: 3 µA (0.003% of FSR) 

Accuracy 
Galvanostat: 0.03% of FSR                                       

Potentiostat: 0.03% of FSR 

EIS Measurement   

Frequency Range 10mHz - 10kHz 

Max AC amplitude 200mV 

AC Applied Potential Resolution 6µV 

Min AC amplitude 60µV 

Data Acquisition   

Acquisition Speed 
250 k samples/s (Aggregate)                                                            

125 k samples/s/ch. (min 2 channels) 

DAC Resolution 16 bits 

FSR: Full Scale Range 
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Powerstat-05E (18 bit) 
Features Cyclic, Linear sweep, and Pulse voltammetry, Battery cycling, 

EIS with Analysis 

Cell Control   

Compliance Voltage  ±15 V 

Max Output Current ±5 A 

Rise Time 25 µs for 1 Ω load (0%-100% signal)  

Slew Rate 1.6 V/µs 

Bandwidth 10 kHz (-3 dB, 1 Ω load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 mA, ±1 A, ±3 A, ±5 A) 

Best Applied Current Resolution .3 µA, 0.003% of FSR 

Applied Current Accuracy 0.03% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GW parallel to 3 pf 

Maximum Update Rate 0.36 µs 

Maximum Scan Rate 100 V/s 

External Control 1 AO, 1 AI, 2 DO 

Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 0.08µV, 8µV  (0.006%, 0.003% of FSR) 

Accuracy 0.08 or 0.03% of FSR 

Current Measurement   

Measured Current Ranges Galvanostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)                                                        

Potentiostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)   

PotentioSTAT Min to Max .1 mA to 5 A 

 Best Resolution Galvanostat: 0.08 µA (0.003% of FSR)                                                        

Potentiostat: 0.08 µA (0.003% of FSR) 

Accuracy Galvanostat: 0.03% of FSR                                  

     Potentiostat: 0.03% of FSR 

EIS Measurement   

Frequency Range 10mHz - 10kHz 

Max AC amplitude 200mV 

AC Applied Potential Resolution 6µV 

Min AC amplitude 60µV 

Data Acquisition   

Acquisition Speed 500 k samples/s (Aggregate)                                                            

250 k samples/s/ch. (min 2 channels) 

DAC Resolution 18 bits 

FSR: Full Scale Range  
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EZstat Mains Supply Input Specifications 

(EZstat Pro, EZstat-Basic, EZstat-Basic 8) 
 

Mains Supply 

Voltage 

Mains Line 

Frequency 

Mains Supply 

Current 

Mains Supply 

Fuse Type 
Fuse Size 

Littel Fuse 

Part Number 

110 – 130 VAC 47 – 60 Hz 4 A 
4 Amp  

Time Lag 
2 X 5mm X 20mm 0215004.HXP 

220 – 240 VAC 47 – 60 Hz 2 A 
2 Amp  

Time Lag 
2 X 5mm X 20mm 0215002.HXP 

  

 
EZstat Mains Power Cable Manufacturer Data 

(EZstat-Pro, EZstat-Basic, EZstat-Basic – 8) 
 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

North American Power Cord

Brand Name Volex

Model Number 17501-10-B1

Rated Voltage 125V

Rated Current 10A
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Powerstat Mains Supply Input Specifications 
 

Mains Supply 

Voltage 

Mains Line 

Frequency 

Mains Supply 

Current 

Mains Supply 

Fuse Type 
Fuse Size 

Littel Fuse 

Part Number 

115 VAC     +/- 10% 50/60Hz 8 A 
8 Amp  

Time Lag 
2 X 5mm X 20mm 0215008.HXP 

127 VAC     +/- 10% 50/60Hz 8 A 
8 Amp  

Time Lag 
2 X 5mm X 20mm 0215008.HXP 

230 VAC     +/- 10% 50/60Hz 4 A 
4 Amp  

Time Lag 
2 X 5mm X 20mm 0215004.HXP 

 
Powerstat Mains Power Cable Manufacturer Data 

 

Saudi Arabia Power Cord

Brand Name Lian Dung

Model Number LT-318 + LT-501  
Rated Voltage 250V

Rated Current 13A

North American Power Cord

Brand Name Volex

Model Number 17501-10-B1

Rated Voltage 125V

Rated Current 10A
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Overall Dimensions and Weight 
EZstat-Basic/Pro overall dimensions  

• 9 in. wide / 22.9 cm 
• 3 in. tall / 7.6 cm 
• 8 in. deep / 20.3 cm 

 
EZstat-Basic/Pro power supply overall dimensions  

• 4 in. wide / 10.2 cm 
• 3 in. tall / 7.6 cm 
• 7 in. deep / 17.8 cm 

 
EZstat-Basic/Pro overall weight 

• 7.55 lbs. / 3.42 kg 
 

EZstat-Basic 8 overall dimensions  
• 18 in. wide / 45.7 cm 
• 9 in. tall / 22.9 cm 
• 20 in. deep / 50.8 cm 

 
EZstat-Basic 8 power supply is included in the instrument chassis 

 
EZstat-Basic 8 overall weight 

• 50 lbs. / 22.68 kg 
 

Powerstat overall dimensions  
• 19 in. wide / 48.26 cm 
• 7.5 in. tall / 19.05 cm 
• 22 in. deep / 55.88 cm including handles 
 

Powerstat power supply is included in the instrument chassis 
 

Powerstat overall weight 

• 50 lbs. / 22.68 kg 

  



EZware Operating Manual 
 
 

  25 
NuVant Systems Inc.  Release - 4.0 
 

INTENDED USE OF EQUIPMENT 
 

The EZstat-Pro is a potentiostat/galvanostat that delivers up to 1 A at ±10 V.  The EZstat-Pro 
LC is a potentiostat/galvanostat that delivers up to 1 mA at ±10 V.  The EZstat-Basic is a 
potentiostat/galvanostat that delivers up to 1 A at ±2.5 V.  The EZstat-Basic LC is a 
potentiostat/galvanostat that delivers up to 1 mA at ±2.5 V.  The EZstat-Basic +5 is a 
potentiostat/galvanostat that delivers up to 1 A at 0 to 5 V. These devices are intended to be used 
on many types of electrochemical experiments including cyclic voltammetry, corrosion studies, 
coating, plating, polarography, pulse voltammetry, potential sweep, controlled current, battery 
cycling and numerous other experiments.  Although it should not damage the EZstat, do not 
attempt to operate this equipment out of the specified voltage and current ranges. 
 

The Powerstat is a potentiostat/galvanostat that delivers up to 5 A at ±10 volts.  It is intended 
for use in electrochemical experiments such as corrosion, coating, plating, polarography and 
pulse voltammetry, potential sweep, controlled current, battery cycling and many other 
experiments.  Although it should not damage the Powerstat, do not attempt to operate this 
equipment out of the specified voltage and current ranges. 

 
 

 



 
 

 
NuVant Systems Inc. 
 

SAFETY 
 

 
 

 It is required that this equipment and software be operated only by trained and qualified 
persons familiar with safe laboratory practices. 

 
The equipment and software described in this manual are supplied in safe condition. To 

avoid injury to an operator, safety precautions
whenever the equipment is operated.  

 
The following symbols may be found on the instrument and within this manual.  Use caution 

where these symbols are found.
 

 
CAUTION:   U

 
 
  ALTERNATING CURRENT:   SINGLE PHASE ALTERNATING 

 

Computer Control
Precautions should be taken to ensure sustained operation of the PC controlling the EZstat

and Powerstat. The software and hardware 
of a PC crash while the software is running: 1) During a shutdown the cell will automatically 
disable when the PC turns off; 2) During a re
Windows re-starts; and 3) During a PC unplug (PC power failure simulation) the cell will 
immediately disable. Yet, in event of a PC system STOP or other unforeseen failure of the PC 
hardware or software the load may remain in an ‘ON’ but uncontrolled state that may damage t
EZstat and Powerstat. 
 
 
 

EZware

 
 

General 
It is required that this equipment and software be operated only by trained and qualified 

persons familiar with safe laboratory practices.  

equipment and software described in this manual are supplied in safe condition. To 
safety precautions throughout this manual must be strictly adhered to 

equipment is operated.   

The following symbols may be found on the instrument and within this manual.  Use caution 
where these symbols are found. 

CAUTION:   USE CAUTION WHERE THIS SYMBOL IS 
YOU MUST CONSULT ALL CASES WHERE THIS 
SYMBOL IS MARKED, IN ORDER TO FIND OUT THE 
NATURE OF THE POTENTIAL HAZARDS 
ACTIONS WHICH HAVE TO BE TAKEN TO AVOID THEM. 

ALTERNATING CURRENT:   SINGLE PHASE ALTERNATING 
CURRENT 

Computer Control and System Safety 
Precautions should be taken to ensure sustained operation of the PC controlling the EZstat

. The software and hardware are designed with the following fail
of a PC crash while the software is running: 1) During a shutdown the cell will automatically 
disable when the PC turns off; 2) During a re-boot the cell will automatically disable when 

and 3) During a PC unplug (PC power failure simulation) the cell will 
immediately disable. Yet, in event of a PC system STOP or other unforeseen failure of the PC 
hardware or software the load may remain in an ‘ON’ but uncontrolled state that may damage t
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It is required that this equipment and software be operated only by trained and qualified 

equipment and software described in this manual are supplied in safe condition. To 
must be strictly adhered to 

The following symbols may be found on the instrument and within this manual.  Use caution 

WHERE THIS SYMBOL IS PRESENT! 
YOU MUST CONSULT ALL CASES WHERE THIS 
SYMBOL IS MARKED, IN ORDER TO FIND OUT THE 

HAZARDS AND ANY 
ACTIONS WHICH HAVE TO BE TAKEN TO AVOID THEM.  

ALTERNATING CURRENT:   SINGLE PHASE ALTERNATING 

 
Precautions should be taken to ensure sustained operation of the PC controlling the EZstat 

esigned with the following fail-safe's in the event 
of a PC crash while the software is running: 1) During a shutdown the cell will automatically 

boot the cell will automatically disable when 
and 3) During a PC unplug (PC power failure simulation) the cell will 

immediately disable. Yet, in event of a PC system STOP or other unforeseen failure of the PC 
hardware or software the load may remain in an ‘ON’ but uncontrolled state that may damage the 
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Grounding 
For the safety of the operator and the equipment, the EZstat and Powerstat must be connected 

by means of a protective conductor to earth ground. Under no circumstances should the ground 
be bypassed. It is advisable not to unplug the instrument when not in use. This protection must 
not be disabled by the use of two-conductor extension cord or adapter, or any other type of 
connection that does not maintain connection to earth ground. 

 

ESD Protection 
 Electrostatic Discharge (ESD) can cause immediate or latent damage to electronic circuits. 

NuVant products are protected against ESD for intended use. It is possible to damage the product 
by delivering electrostatic discharges when touching, moving the product, or connecting leads. It 
is advisable for operators to ground and discharge themselves before touching the inside 
electronics on this product. It is advisable to ground and discharge any leads and the 
electrochemical cell before connection to the EZstat and Powerstat. 

 

 
AC Supply Voltage 

AC voltage is present in the equipment when power is off.  User must disconnect the 
appliance cord to remove mains voltage from the instrument.  The appliance cord should be 
easily accessible by the user. 

 
Before connecting the power supply to the equipment, make sure that the line voltage is 

appropriate. Never operate the equipment from a line voltage or frequency in excess of the 
specifications. Read the MAINS SUPPLY INPUT SPECIFICATIONS for voltage and fuse 
information. The equipment may be damaged by the application of incorrect line voltage. 
Voltage and current conditions are sufficient to cause injury and possible death.  
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Placement and Surroundings of the EZstat and Powerstat 

 
DO NOT place the instrument in a location where the user cannot access the appliance cord 

or power supply. Place the instrument in a location where the appliance cord can be easily 
disconnected by the user. 
 

The EZstat and Powerstat should be placed on a flat, clean, hard surface that can support the 
weight of the instrument (7.55 lbs.). At least, 2 inches of space must be available at the rear to 
allow the flow of air. At least, 3 inches of space must be available on both sides to allow the flow 
of air. Obstructed airflow can lead to instrument malfunction over time. At no time should there 
be obstructions in front of the instrument. The user needs access to the controls and electrode 
cables located in front of the EZstat and Powerstat. 

 
Do not place any objects on top of the EZstat or Powerstat.   

 

Normal Environmental Conditions for EZstat and Powerstat 
The EZstat and Powerstat are designed to operate indoors, in a laboratory environment. Do 

not operate the instrument outdoors, as this may place the user in a hazardous situation due to 
unknown environmental conditions. Outdoor use of the instrument may cause a failure of 
operation due to environmental conditions. The EZstat and Powerstat are rated to operate at an 
altitude of up to 6562 feet, or 2000 meters. The ambient temperature for operation is between 41 
degrees Fahrenheit /5 degrees Celsius and 104 degrees Fahrenheit / 40 degrees Celsius.  

 
Indoor use only 
Operate between 41° F ~ 104° F / 5° C ~ 40° C 
Altitude of no more than 6562 FT / 2000 M 
Humidity of up to 80% 
Pollution degree 2 
 

Instrument operation outside of these conditions will reduce instrument lifetime. 
 

Although the Main supply voltage can fluctuate with load conditions, the EZstat and 
Powerstat will continue to operate properly if these fluctuations do not exceed ± 10% of the 
specified instrument supply voltage. Main supply voltage settings on the EZstat and Powerstat 
have a specified range itself for that particular setting.  ± 10% applies to the upper and lower 
limits of that setting. The main supply voltage frequency for operation is 50Hz to 60Hz.   
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Accessory Cables 
Only the cables supplied with the EZstat and Powerstat should be used. These cables include: 
Electrode Cable Assembly (See Figure 1), High Speed USB Cable, and AC Power Cable. Do 
NOT replace cables without contacting NuVant Systems Inc. Replacement cables must be 
procured from NuVant Systems. 
 

Technical Assistance Contact Information 
NuVant Systems, Inc.  

130 N. West Street  
Crown Point, IN 46307 
Toll Free: 866-894-7337 

Office: 219-644-3231  
Fax: 219-779-9675 
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HARDWARE CONVENTIONS 
 

o Physical switches and connectors on the front panel relevant to operation are 
designated as Bold Blue text.  For example, Main Power Switch and Cell 
Enable Switch. 

o Physical switches and connectors on the back panel relevant to operation are 
designated as Bold Red text. For example Data Communication Port. 

 
 

HARDWARE INSTALLATION 
 

Description of Controls and Connections 
This section provides a general description of the controls and indicators on the EZstat front 

and back panels. 
 

EZstat Front Panel 
Figure 1 shows the EZstat front panel and cable assembly. 

  

 
 

Figure 1 EZstat Front Panel.  Top image: instrument in plastic casing.  Bottom image: 
instrument in metal casing 
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Powerstat Front Panel 

Figure 2 shows the Powerstat front panel and cable assembly. 
 

  

 Figure 2 Powerstat Front Panel  

 

 

Figure 3  Separate Working and Working Sense Electrode Cables 

 
1. Counter, Working and Reference Electrode Cable Assembly – The system allows current 
flow between the counter (Red) and working (Black) electrodes at a controlled current or 
potential. When under potential control, the applied potential is measured between the working 
and the reference (White) electrodes. The reference lead may be connected to an internal 
reference electrode. If no reference electrode is used, the reference lead must be connected to the 
counter electrode lead. For operation as a potentiostat or galvanostat all three leads must be 
properly connected. The EZstat must be used with the cables provided.  Recent EZstat serial 
numbers have separate Working and Working Sense Cables, Figure 3.  When using separate 
Working and Working Sense Cables all four cables must be connected. 
 
2. Main Power Switch – This switch is used to turn the EZstat system on or off. Pressing this 
switch on will allow the main AC voltage to be applied to the transformers of the power supplies. 
Pressing this switch to the off position will disconnect the AC voltage from the transformers of 

1 2 3 

4 

5 
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the power supplies. On the instruments with plastic casing, this switch lights green when on.  
The metal casing instruments light up when the power is on. 
 
3. Cell Enable Switch – Places the test device in series with the potential follower board. Also 
acts as a safety feature, wherein the device is isolated from the current flow when the switch is in 
the off position. In the off position potential will still be measured but not controlled. When this 
switch is depressed AND the cell is enabled in the software this switch will illuminate. When the 
software control program is exited, this switch will not be illuminated even when depressed 
because exiting the software control program disables the cell automatically.  There is no cell 
enable switch for the metal casing instruments.  Cell enable is determined by the EZware 
software. 
 
4. External Input  – A standard BNC connector allows connection to an external signal source. 
Signals of up to ± 10 volts can be applied to this connection. The input impedance is 47K Ohms.  
There is no external input connector on the metal casing instruments. 
 
5. Electrode Connector – Attach the electrode cable assembly to this connector. On the 
instruments with plastic casing, this connector is a twist-lock type with the addition of a “keyed” 
connection. The electrode cable can be installed in only one way, thus ensuring the safest cable 
installation.  On the instruments with metal casing, this is a 15 pin rs232 connector. 

 
 
Caution:  Make sure the Cell Enable switch is in the Disabled position before 
installing the Electrode cable. 
 

 
Powerstat-20 Front Panel 

 
Figure 4 shows the Powerstat 20 front Panel along with the cables that are required: 
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Figure 4: PowerStat-20 front Panel & Cables Assembly 

 
All the cables need to be connected to the electrochemical device under investigation 
(description follows) 
 
1. Power Supplies Switches. Before the instrument can be used the power supplies switches 
need to be turned ON. 
2. Main Power Switch. After the power supplies switches (1) are turned ON the instrument 
main power switch is turned ON. 
3. Cell Enable Switch. The Cell Enable switch needs to be turned ON when ready to perform 
the experiment. Turn ON the Cell Enable switch only after all the cables are properly attached to 
the electrochemical cell under investigation. 
4. High Current Working & Counter Electrode Cable Connectors. The high current cables 7 
attach to these connectors. The RED cable attaches to the RED connector and the BLACK cable 
attaches to the BLACK connector. PROPER CARE MUST BE EXERCISED SO THAT 
THESE CABLE NEVER SHORT TO EACH OTHER.  
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5. Electrometer Power Connector. The electrometer cable 8 attaches to this connector. The red 
and black alligator clips at the opposite end of cable 8 are the connectors of the sense leads and 
they attach to the electrochemical cell where the thick high current cables attach, matching the 
colors (RED to RED and BLACK to BLACK). 
6. Electrometer Sense Lead.  The electrometer Sense Lead connects to the electrometer box 
(black box embedded in cable 8) via the banana plug. 
7. High Current Cables. The RED and BLACK high current cables connect to connectors 4. 
8. Electrometer Cable. The electrometer cable connects to connector 5. 
 

Powerstat-20 Back Panel 
 
Figure 5 shows the Powerstat 20 back Panel. 
 

 

Figure 5: PowerStat-20 Back Panel 
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1. Main Power Connector. Cable 9 (shown in Fig. 4) connects to the main power 
connector 1. It is very likely that the user will have to provide his/her own connector to 
accommodate the wall power outlet specific to the country where the instrument will be used. 
2. USB Cable.  A standard USB cable (cable 10 in Fig. 4) connects the instrument to the 
computer via connector 2. 
3. K-type Thermocouple Connectors. The instrument provides the possibility to read 2 
temperature channels using 2 K-type thermocouples connected to receptacles 3 
4. Cooling Fans.  Care must be exercised to never obstruct the cooling fans 4. 
 

Procedure for Connection of Electrode Cables to an Electrochemical 
Device 

Electrodes should never be connected or disconnected from the EZstat of Powerstat when the 
cell is enabled. If the software is running, disable the cell using the software AND by putting the 
Cell Enable Switch in the out position, whether or not it is illuminated. For operator safety, and 
protection of the EZstat and Powerstat electronics, always connect and disconnect electrodes in 

the following order (NOTE: counter, reference, working sense (if available), and 
working electrodes must ALL be connected to the electrochemical device.  In a 
typical 3-electrode system the working sense is shorted to the working electrode): 

1) Electrode connection; 

 a) With the cell disabled connect the Green Ground lead, if used; 
 b) With the cell disabled connect the White Reference electrode lead; 
 c) With the cell disabled connect the Red Counter electrode lead 

d) If present, with the cell disabled connect the Black Working Sense electrode lead; 
 e) With the cell disabled connect the Black Working electrode lead. 

2) Electrode disconnection; 

 a) With the cell disabled disconnect the Black Working electrode lead; 
b) If present, with the cell disabled disconnect the Black Working Sense electrode lead; 

 c) With the cell disabled disconnect the Red Counter electrode lead; 
 d) With the cell disabled disconnect the White Reference electrode lead; 
 e) With the cell disabled disconnect the Green Ground lead, if used; 
 f) Do not enable the cell unless all electrodes are connected correctly. 
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EZstat Back Panel 
  

 

 

Figure 6 EZstat Back Panel Top image: instrument in plastic casing.  Bottom image: instrument in metal casing 

1. AC Power Input – The EZstat is supplied with an external power supply.  Two different units 
are available, 120 VAC, 47-60 Hz and 220 VAC 47-60 Hz. Within the power supply there is 
either a 2 A or 4 A slow blow fuse (see table on page 17).  NuVant recommends that the power 
supply be kept at least 1 foot away from the EZstat to reduce the signal noise from the power 
supply. 
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2. Serial Number Plate – Removal of or defacing the serial number plate will void the warranty. 
 
3. Digital Analog I/O Connections – This feature provides the user with the ability to attach 
peripheral equipment to the EZstat. Control is accomplished using the EZstat/LabVIEW 
operating platform without the addition of other DAQ cards. If you would like assistance using 
these Input/Output connections, please contact NuVant Systems for additional information. From 
left to right: Pin 1 is Analog output (AO1); Pin 2 is Analog input (AI5); Pin 3 is Digital 
Input/Output (P1.6); Pin 4 is Digital Input/Output (P1.7) Pins 5~8 are unused. 
 
4. Data Communication Port – The data acquisition (DAQ) port communicates with a 
computer using a USB cable. Use only the cable provided by NuVant. 
 
5. Cooling – Allow at least 2 inches of space behind, above and to the sides of the EZstat. 
Periodically inspect the fan ports to make sure debris does not obstruct air flow. 
 
6. External Power Supply – The external power supply is used to convert the 120 VAC line 
voltage to appropriate DC voltages for the EZstat. 
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Powerstat Back Panel 

  

 

Figure 7 Powerstat Back Panel 

1. AC Power Input – 8 A at 250 VAC Slow blow fuse for voltage selections of 115/127VAC or 
4 A at 250 VAC Slow blow fuse for voltage selection of 230 VAC 50~60Hz. Use only the 
supplied power cable to run this instrument. Contact NuVant systems if a replacement is needed. 
 
2. Main Power Voltage Selector Switch and AC Fuse Holder – External AC fuse holder. 8 A 
at 250 VAC Slow blow fuse for voltage selections of 115/127VAC or 4 A at 250 VAC Slow 
blow fuse for voltage selection of 230 VAC 50~60Hz. 
 
3. AC Main Power Switch – AC main power switch. This must be on for the front panel Main 
Power Switch to illuminate. 
 
4. Data Communication Port – The data acquisition (DAQ) port communicates with a 
computer using a USB cable. Use only the cable provided by NuVant. 
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5. Serial Number Plate – Removal of or defacing the serial number plate will void the warranty. 
 
6. Cooling Fan – Allow at least 2 inches of space behind and to the sides of the cooling fans. 
Periodically inspect the fan ports to make sure debris does not obstruct air flow. 
 
7. AC Power Cable – The power cable must be plugged firmly into the back of the instrument. 
The other end of the power cable must be plugged into a grounded circuit of the correct polarity 
and voltage. The voltages are: 115/127VAC or 230VAC 50~60Hz. Have a certified electrician 
verify the earth grounding of the wall outlet. Do not replace this cable with any other similar 
cable. This power cable supplied is rated for the instrument. 
 
8. USB Data Communication Cable – Do not connect this cable to the computer until the 
software is installed. Ensure this cable is inserted completely into the instrument and computer 
during use. Do not connect a USB extension cable to this cable. Do not replace this cable without 
contacting NuVant Systems to obtain an appropriate cable. 
 
PowerStat 20 Front and Back Panels 
 
 

CLEANING AND MAINTENANCE 
  
 The EZstat and Powerstat require minimal maintenance. The instrument must be clean 
and free of oil, dust and debris. If a buildup occurs, unplug the instrument from the mains AC 
Power Input. Use a soft cloth to wipe the instrument clean. If necessary, use a small amount of 
soap and water on the cloth to remove deposits. Make sure all the switches, connectors and fan 
ports are clean. A small brush can be used to clean the fan ports. Check the fan ports regularly 
for buildup. If there is visible damage, worn electrode cables or power cable, do NOT operate the 
instrument. Contact NuVant for replacement cables or for return of instrument for repair. 
 
 
 

 
 
SERVICE AND REPAIR 

 
ONLY NuVant is authorized to service and repair the EZstat and Powerstat. ONLY 

NuVant staff should open the chassis or remove instrument components. ONLY NuVant 
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Systems can verify safe operation of the instrument after a repair. If there are doubts about 
instrument functionality, contact NuVant at (219) 644-3231. 
 

SOFTWARE INSTALLATION  
 
The EZware installation DVD includes the LabVIEW Runtime Engine, the NI-DAQmx driver, 
the NI-Serial driver and the EZware software.  Version specific installation instructions are 
provided with each EZware installation DVD. Users are urged to read the instructions before 
installing the software and connecting hardware.  Please note that the recommended pattern is 
to install the software prior to connecting the hardware so all hardware is automatically 
recognized by both the Windows and National Instruments New Hardware Wizards. 
 
1.0 Install the LabVIEW Runtime Engine using the default installation options. Restart the 

computer after installation is complete. 
2.0 Install NI-DAQmx with the default installation options. Restart the computer after 

installation is complete. 
3.0 If the temperature and/or mass flow controller options are ordered, the NI-Serial driver on the 

installation DVD must also be installed.  Installation and COM port configuration 
instructions are provided under separate cover when these options are ordered. 

4.0 Install the EZware software.  A re-boot is not required after installing the EZware software. 
5.0 Connect the USB cable provided to the back of the EZstat or Powerstat but do not plug it into 

the computer yet. 
6.0 Apply power to the EZstat by connecting and plugging in the external power supply.  Ensure 

the physical Cell Enable switch is in the out (off) position.  Press the power switch on the 
front panel.  This power switch should illuminate green and you should hear the sound of the 
cooling fan when the instrument is on. 

7.0 Connect the USB cable to your computer and wait to see the new hardware installed twice.  
The hardware must be recognized first by Windows and then by the National Instruments 
Measurement & Automation Explorer (MAX). 

  
NuVant provides periodic software upgrades to ensure that instruments are working at the 
highest efficiency. Current versions of the EZware software are available through 
www.nuvant.com. Contact NuVant for additional information if necessary. 
 
The NI-DAQmx driver and LabVIEW Runtime Engine may be downloaded from the National 
Instruments website www.ni.com  or through the following sites: 
 
LabVIEW 2012 Runtime Engine:  http://joule.ni.com/nidu/cds/view/p/id/3710/lang/en  
NI-DAQmx v9.7 Driver:  http://joule.ni.com/nidu/cds/view/p/id/3811/lang/en  
NI Serial Driver: http://joule.ni.com/nidu/cds/view/p/id/3680/lang/en  
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SOFTWARE AND INSTRUMENT STARTUP 
 

1. When the software is opened, three windows will open simultaneously: [NuVant 
EZware], [Display Cell Data], and [Edit Single Method] (Fig. 6). 

Figure 6.  Startup windows of the EZware software 
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2. [NuVant EZware] will show red text, indicating that there is no instrument connected to 
the software.  Select Tools→Configure in [NuVant EZware] to connect the instrument to 
the software (Fig. 7). 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 7. Connection of instrument to software 
 

3. Configure will open [Configure Instrument].  If the instrument is properly connected to 
the computer, the device will be listed in the box on the left of the window (Fig. 8, 
highlighted in blue).  If the device is not listed, ensure that the instrument is properly 
connected and turned on, and then click Check for new device.  Once the instrument is 
indicated on the device list, highlight the device and click Done. 

 

Figure 8. [Configure Instrument] window 
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4. In [Model Selection] (Fig. 9), click the arrows or the “No Selection” text to display the 
instrument options and select the proper instrument model.  Warning: Make sure the right 
model is selected, otherwise the instrument will not function properly. Click Continue to 
save the proper instrument.  Note: newer instrument models will automatically be 
identified by the software and this dialog box will not appear. 

 
Figure 9. [Model selection] 

 
5. [NuVant EZware] will now display the logo for the selected instrument. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10. [NuVant EZware] with the instrument selected 
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6. Select Method→General Settings in [Edit Single Method] to choose the proper 
instrument settings for the experiment (Fig. 11). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11. [General settings] 
 

7. In [General Configuration], click the text box next to Potentiostat Default Current Range 
to select the proper current range.  If the scan rate of the sweep experiment is 100 mV/s 
or less, auto-ranging can be used.  To utilize the auto-range option, first select the starting 
range via the text box next to Potentiostat Default Current Range and then select the 
required ranges located in the gray box next to Potentiostat Current Auto Range.  Click 
Done to save the settings. (Fig. 12) 
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Figure 12. [Method General Configuration] with current range selection 
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RECIPE DESIGN 
 

General Recipe Notes 
 

• At any point, an experiment can be reset to the default settings by going 
to [NuVant EZware] File→ New. 

• Many of the following experiments are described with the recipe editor in 
potentiostat mode.  When galvanostat mode is available, the green Mode 
button will be activated in [Edit Single Method]. 

 

Cyclic Voltammetry  
 

1. For cyclic voltammetry, go to [NuVant EZware] Technique→ Sweep Techniques→ 
Cyclic Voltammetry (Fig. 13). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13. Cyclic voltammetry  
 

2. [Edit Single Method] shows the input boxes for Cyclic Voltammetry.  Pretreatment 
Time [s] is the duration at a soak potential, Pretreatment Potential [V].  After the 
pretreatment period, the scan will begin at the Initial Potential [V].  Often, the 
Pretreatment Potential [V] and the Initial Potential [V] will be the same.  The scan will 
proceed to the First Vertex Potential [V] from the Initial Potential [V] and then to the 
Second Vertex Potential [V]. The Number of Segments is the number of each individual 
anodic and cathodic scan.  If the user wants two full scan cycles, there will be four 
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segments.  The Final Potential Value [V], if selected as a different value from the Second 
Vertex Potential [V], scans from the Second Vertex Potential [V] to the selected value.  
This scan is in addition to the Number of Segments chosen.  If the Cell ON After 
Measurement box is selected, the potential will soak at this value when the experiment is 
complete. Once the desired values have been entered into the window, the waveform will 
be displayed on the right of the window (Fig. 14). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14. Cyclic Voltammetry recipe editor 
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Linear Sweep Voltammetry 
 

1. For a linear sweep voltammetry, go to [NuVant EZware] Technique→Sweep 
Techniques→Linear Sweep Voltammetry.   [Edit Single Method] will now show the 
input boxes for Linear Sweep Voltammetry.  Pretreatment Time [s] is the duration at a 
soak potential, Pretreatment Potential [V].  After the pretreatment period, the scan will 
begin at the Initial Potential [V].  Often, the Pretreatment Potential [V] and the Initial 
Potential [V] will be the same.  The scan will proceed to the First Vertex Potential [V] 
from the Initial Potential [V].  In linear sweep voltammetry, there is no reverse scan.  
Standby Potential Value [V] can only be used if the Cell ON After Measurement box is 
selected.  If this option is used, then the potential will soak at the desired value when the 
experiment is completed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 15. Linear Sweep Voltammetry  
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Multi Vertex Waveform 
 

1. For multi vertex waveform, go to [NuVant EZware] Technique→Sweep Techniques→ 
Multi Vertex Waveform.  [Edit Single Method] shows the input boxes for Multi Vertex 
Waveform (Fig. 16).   
 

Figure 16.  Multi Vertex Waveform  recipe editor 
 
Pretreatment Time [s] is the duration at a soak potential, Pretreatment Potential [V].  
After the pretreatment period, the scan will begin at the Initial Potential [V].  Often, the 
Pretreatment Potential [V] and the Initial Potential [V] will be the same.  The scan will 
proceed to the First Vertex Potential [V] from the Initial Potential [V].  Vertexes 
Potential [V] allows for the user to select any number of vertices and their respective 
potential values.  The first vertex potential is labeled “0” in the left box, and its 
corresponding potential value is entered in the right box.  The scan will proceed from the 
Initial Potential [V] to the Vertex Potential [V] “ 0”.  To create more vertices, change the 
left box to “1” and select the potential value for this vertex.  Create more vertices if 
necessary.  The Number of Periods is the number of times the scan from the Initial 
Potential [V] to the First Vertex Potential [V] and back to the Initial Potential [V] is 
repeated.  Figures 17a through 17d show how to set the vertex potentials to the desired 
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values so that the waveform follows the pattern described above.   The example 
experiment has a pretreatment of 0 V for 10 s, followed by a 100 mV/s scan to 1V, a 100 
mV/s scan to 500 mV, and a 100 mV/s scan back to 1V.  The scan from 1V to 500 mV 
and back to 1V is repeated (the Number of Periods is 2).  In Figure 17c, the Final 
Potential Value [V] is set to 0.5 V, meaning that after the 2 periods are complete, the 
potentiostat will scan back to a final potential of 0.5 V.  This scan is in addition to the 
Number of Periods chosen.  If the Cell ON After Measurement box is selected, the 
potential will soak at this value when the experiment is complete. To demonstrate an 
alternate view, in Figure 17d, the Final Potential Value [V] is set to 0 V. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Figure 17a. Vertex Potential 0 set to 1 V 
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Figure 17b. Vertex Potential 1 set to 0.5 V 
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Figure 17c. Vertex Potential 2 set to 1 V 
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Figure 17d. Final Potential Value set to 0 V 
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Programmable Potential Waveform – Hold/Ramp/Step 
 

1. For programmable potential waveforms, go to [NuVant EZware] 
Technique→MISC→Programmable Potential Waveform – Hold/Ramp/Step. [Edit Single 
Method] shows the input boxes for Programmable Potential Waveform –Hold/Ramp/Step 
(Fig. 18a-f). 

 
 

 
 
 
 
 
 
 
 
 
 
 

Figure 18a. Programmable Potential Waveform recipe editor 
 

Pretreatment Time [s] is the duration at a soak value, Initial Value.  After the 
pretreatment period, the scan will begin at the Initial Potential [V]. Steps in the 
experiment are inserted via the arrow buttons circled in red in Figure 18b.  The first step 
after the pretreatment is step “0”.  By clicking the box next to Hold/Ramp/Step (Fig. 
18d), the user can select the potential or current control required.  VRTX Value is the set 
point of the Hold/Ramp/Step. Rate/Time to Next is scan rate or time between steps, 
depending on which control mode the user is in. In Figure 18b, step “0” is a “ramp to” 1 
V at a rate of 0.5 V/s.  Figure 18c shows step “1” set to a “ramp to” -1 V at a rate of 1 
V/s.   Figure 18d and 18e show the selection of step “2”, which is initially grayed out, as 
“step to”, and the selection of “step to” as 0.5 V. In the case of the “step to” selections, 
the Rate/Time to Next input box is not used and can be ignored. Figure 18f shows a final 
“ramp to” 0 V at 1 V/s in step “3”. Repetitions, if used, will repeat the experiment 
starting at step “0”. If the Cell ON After Measurement box is selected, the potential will 
soak at the Standby Value when the experiment is complete. 
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Figure 18b. Selecting experimental steps and “ramp to” 1V in step “0” 

 
 

 
 
 
 
 
 
 
 

 
 
 
 

Figure 18c. “Ramp to” -1V in step “1” 
 

0 
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Figure 18d. Selection of “step to” in step “2” 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 18e. “Step to” 0.5 V in step “2” 
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Figure 18f. “Ramp to” final 0V 
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Battery Cycling 
 

1. For battery cycling, go to [NuVant EZware] Technique→Electrochemical Energy 
Sources→Battery.  [Edit Single Method] shows the input boxes for Battery (Fig. 19).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 19.  Battery recipe editor 
 
Set Source Mode to “Galvanostat”. Pretreatment Time [s] is the duration at a soak 
current, Pretreatment Current [A].  Charging Current [A] is the soak current, which 
continues until the voltage reaches the Charging Voltage Limit [V].  Discharging Current 
[A] is the soak current, which continues until the voltage reached the Discharging 
Voltage Limit [V].  Log Interval [s] is the period between acquired points for the 
charging and discharging.  The recipe is defaulted to perform the charging first.  The 
discharge can be performed first by selecting Discharge First.  Time Limit [s] will stop 
the experiment after a certain period of time, superseding any potential limits set.  
Number of Repetitions determines how many times a charge/discharge or 
discharge/charge cycle is performed.   
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Differential Pulse Voltammetry 
 

1. For differential pulse voltammetry, go to [NuVant EZware] Technique→Pulse 
Techniques→Differential Pulse Voltammetry.  [Edit Single Method] shows the input 
boxes for Differential Pulse Voltammetry (Fig. 20).  
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 20. Differential Pulse Voltammetry recipe editor 
 
Pretreatment Time [s] is the duration at a soak potential, Initial Potential [V].  After the 
pretreatment period, the scan will begin at the Initial Potential [V].  Final Potential [V] is 
last potential step value of the experiment.  Pulse Amplitude [V] is the magnitude of each 
pulse.  Pulse Increment [V] is the change in potential after one period.  Pulse Period [s] is 
change in time after one period.  Pulse Width [s] is the change in time during each pulse.  
Standby Potential [V] sets the cell to a desired potential at the end of the experiment, only 
if Cell ON After Measurement is selected. 
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Normal Pulse Voltammetry 
 

1. For normal pulse voltammetry, go to [NuVant EZware] Technique→Pulse 
Techniques→Normal Pulse Voltammetry.  [Edit Single Method] shows the input boxes for 
Normal Pulse Voltammetry (Fig. 21).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 21. Normal Pulse Voltammetry recipe editor 

 
Pretreatment Time [s] is the duration at a soak potential, Initial Potential [V].  After the 
pretreatment period, the scan will begin at the Initial Potential [V].  Final Potential [V] is 
last potential step value of the experiment.  Pulse Amplitude [V] is the size of the initial 
pulse.  Pulse Increment [V] is the change in potential between each pulse potential.  Pulse 
Period [s] is change in time after one period.  Pulse Width [s] is the change in time during 
each pulse.  Standby Potential [V] sets the cell to a desired potential at the end of the 
experiment, only if Cell ON After Measurement is selected. 
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Step Impedance Spectroscopy (SIS) 
 

1. To set up a step impedance spectroscopy (SIS) recipe, go to [NuVant EZware] 
Technique→Step Techniques→Step Impedance Spectroscopy. [Edit Single Method] 
shows the input boxes for Step Impedance Spectroscopy (Fig. 22). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 22. Step Impedance Spectroscopy recipe editor 
 

Pretreatment Time [s] is the duration at a soak current, Initial Current [A].  After the 
pretreatment period, the scan will begin at the Initial Current [A].  Pulse Amplitude [A] is 
the size of the pulse.  For a battery discharge experiment, the sign of the pulse amplitude 
value should be opposite to that of the displayed battery voltage in the [NuVant EZware] 
window.  For a charge experiment, the sign should be the same.  Pulse Width [s] is the 
duration of the pulse.  Relaxation Period [s] is the length of time after the pulse that the 
current sits at the Initial Current [A].  Sampling Interval [ms]is the period between 
acquired points during the experiment. 
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Electrical Impedance Spectroscopy (EIS) 
Note: EIS is only available for the EZstat-Pro EIS.  To use the EIS feature, please download the 
EIS software, [NuVant EZware-EIS], available at http://nuvant.com/download-
software/software/ , or install the EZware-EIS provided in the CD. 
 

1. The EIS software controls are located on the main [NuVant EZware-EIS] window. 

Figure 23. EIS control window in galvanostat mode 
 

The instrument can perform in “Galvanostat” or “Potentiostat” mode using the button on the top 
left of the window (seen here as “Galvanostat”). When running a recipe, select the current range 
for the EIS test by going to Edit→General Settings. It should not be confused with the current 
range on the front panel, which is used when in manual mode. If during the scan any of the 
potential or current channels go out of range, the measurement should be repeated with different 
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amplitudes and proper current ranges. Before each measurement make sure the In Range 
indicators are properly reset (indicators are green).  
 
Cell Potential and Cell Current display the respective potential and current values of the system 
in real-time.  In manual “Galvanostat” mode, the end-user can select a value for Current CTRL. 
In manual “Potentiostat” mode, the end-user can select a value set the Potential CTRL and use 
this value as the DC Bias by pushing Use Manual Set Value as Bias.  Enter the Pretreatment 
Time (s), DC Bias (if not already selected), AC Amplitude, Start Frequency, Intermediate 
Frequency, End Frequency. Choose the Steps per Decade for Low Frequency (between the start 
and intermediate frequencies) and High Frequency (between intermediate and end frequencies). 
Decide whether to “Start From Bottom” or “Start From Top” by selecting one of these options.  
The resulting data can be displayed as either Nyquist Plot or Bode Plot by using the slider 
button.  The resulting data is displayed on the right half of the screen.    
 
After the data is collected File→Export saves the data as .csv file or a file compatible with the 
publicly available EIS Spectrum Analyser:  http://www.abc.chemistry.bsu.by/vi/analyser/  
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STOPPING / RESTARTING AND EXPERIMENT 
 

1. An experiment can be stopped and restarted.  To stop an experiment, click on Stop in 
[NuVant EZware] (Fig. 24.). Data from the unfinished experiment can be saved, as 
outlined in the AXES RESCALING / SAVING DATA section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 24. Stopping an experiment 
 

2. Once the experiment has been stopped, aspects of the experimental setup, such as the 
recipe, can be modified.  Once the user is satisfied with the changes, the experiment can 
be restarted by selecting Start in [NuVant EZware].  Note:  the experiment will restart 
from the beginning, not from the point where it was stopped. 
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SAMPLE EXPERIMENTS 
 

Linear Voltammetry – Corrosion Experiment 
 

1. For a corrosion experiment, select [NuVant EZware] Technique→Sweep Techniques→ 
Linear Sweep Voltammetry(Fig. 25). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 25. Linear Sweep Voltammetry 
 

2.  [Edit Single Method] now displays the input boxes for Linear Sweep Voltammetry 
(Fig. 26).  The proper values can be input into the fields on the left of the window. 
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Figure 26. Linear Sweep Voltammetry recipe editor 
 

3. To start the experiment, click Start in [NuVant EZware]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 27. Starting the recipe 
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4. The data collection is visualized in [Display Cell Data].  To see the data, Update needs to 
be selected to read Update On (Fig. 28). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 28. [Display Cell Data] 
 

5. To change the style of the graph, click the style image at the top right of the window.  
Hover over Common Plots and select the desired style.  The axes can also be changed to 
any of the options listed on the left of the window (Fig. 29). 
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Figure 29. Data display style and axes change 

 
6. When the experiment is complete, the final, unfiltered data can be visualized by clicking 

Last Run Data on the top left of the window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 30. Completed data collection (Last Run Data) 
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Cyclic Voltammetry (5mM K4Fe(CN)6 and K3Fe(CN)6 in 1M KNO3) 
 

1. For a cyclic voltammetry experiment, go to [NuVant EZware] Technique→Sweep 
Techniques→Cyclic Voltammetry (Fig. 31). 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 31. Cyclic voltammetry selection 
 

2.  [Edit Single Method] now shows the input boxes for Cyclic Voltammetry .  Once the 
desired values have been entered into the window, the waveform will be displayed on the 
right of the window (Fig. 32). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 32. Cyclic Voltammetry 



EZware Operating Manual 
 
 

  70 
NuVant Systems Inc.  Release - 4.0 
 

3. When the recipe is complete, the experiment can be started by clicking Start in [NuVant 
EZware] (Fig. 33). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 33. Starting the recipe 
 

4. [Display Cell Data] shows the data being collected as the experiment is running (Fig. 
34a).  Once the experiment is complete, the final data can be viewed by clicking Last 
Run Data on the right of the window (Fig. 34b). 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 34a. Real time data collection 
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Figure 34b. Completed data collection 
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Step Impedance Spectroscopy (3.78V Li ion battery) 
 

1. To set up a step impedance spectroscopy (SIS) recipe, go to [NuVant EZware] 
Technique→Step Techniques→Step Impedance Spectroscopy. [Edit Single Method] 
shows the input boxes for Step Impedance Spectroscopy (Fig. 35). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 35. SIS selection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



EZware Operating Manual 
 
 

  73 
NuVant Systems Inc.  Release - 4.0 
 

2. [Edit Single Method] now shows the input boxes for Step Impedance Spectroscopy.  
Once the desired values have been entered into the window, the waveform will be 
displayed on the right of the window (Fig. 36). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 36. SIS 
3. When the recipe is complete, the experiment can be started by clicking Start in [NuVant 

EZware] (Fig. 37). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 37. Starting the recipe 
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4. The data can be seen by going to the [Display Cell Data] window.  Figure 38 shows the 
data after the experiment is complete. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 38. Completed data collection 
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5. Right-clicking on the potential axis enables the user to autoscale the axis, as seen in 
figure 39. 

Figure 39. Completed data collection after autoscale 
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DATA VISUALIZATION AND ANALYSIS 
 

Axes Rescaling 
 

1. The following images of Figure 40 demonstrate how to rescale the y-axis.  The same 
procedure can be applied to rescale the x-axis.  Double clicking a value on either axis 
highlights the value and allows the user to input a desired value. 
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Figure 40. Rescaling axis 
 

2. The left side of [Display Cell Data] allows for the user to change what data is displayed 
on the axis.  Figure 41, for example, shows the display for potential and current versus 
time.  The potential is the left y-axis and the black data set.  The current is the right y-axis 
and the red data set. 
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Figure 41. Potential and Current vs. Time 
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Saving Data 

 
1. Final data can be exported via two options.  In order to open the recipe file and data in 

EZware, the file must be saved as a “.nuvdt” file.  To do this, go to File→Save and save 
in the desired location.  This option will save all experimental settings that are currently 
entered in all recipe editors and method settings. For experiments that create large data 
files, the user will be prompted to save the file as a “.nuvdt” file when the experiment is 
started. The second option is to save the data as a “.csv” file, which can be read by other 
data processing programs.  To access this option, go to Tools→File Export→Data 
Configuration (Fig. 42). A dialogue box appears allowing the user to select the output 
data (Fig. 43).  Once the export data is selected, go to File→Export as and save in the 
desired location. 

 
 

 
Figure 42. Saving data as a “.csv” file 
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Figure 43. Data selection for export 
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Data Analysis – Area Calculations 
 

1. With the final experimental data, the user can analyze it in [Display Cell Data].  Figure 
44a shows an example of final data collected from an experiment.  Figure 44b shows the 
same data viewed as Potential & Current vs, Time, where the black line is potential and 
the red line is current.  Viewing the data in this method allows the user to crop the entire 
data set to the section of data that is going to be analyzed. 

 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 

Figure 44a. Last run data to be used in analysis.  
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Figure 44b. Last run data viewed as Potential & Current vs. Time 

 
2. To crop the entire data set to a smaller section of data, move the red and black cursors so 

that they are the end points of the desired data window.  As an example, Figure 45 shows 
the cursors moved so that the data window is the second full anodic scan. 
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 Figure 45. Data cursors moved to show data window selected for analysis 
 
 

3. After the desired data window has been selected, click Crop to Cursors, located at the 
bottom of the window.  [Display Cell Data] will now show only the data selected (Figure 
46).  To analyze this data, go to Data→Analyze Selected. 
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4. [Analyze Data] will open displaying th
By going to Plots→Plot Cursors
holding CTRL, two cursors
baseline on the data and can be mo
shows [Analyze Data] 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

EZware

 
 

Figure 46. Selected data for analysis 
 

will open displaying the data the user has selected from
Plot Cursors→Cursor Along Plot, and clicking the mouse while 

holding CTRL, two cursors can be placed on the data.  These cursors are used to draw a 
baseline on the data and can be moved to any desired location on the data.  Figure 

 with the cursors moved to the endpoints of the data.
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These cursors are used to draw a 
the data.  Figure 47 

cursors moved to the endpoints of the data. 
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Figure 47. [Analyze Data] window with the cursors moved to data endpoints 
 

5. To draw a baseline, go to Analysis→Draw Base Line (Figure 48a).  The baseline will be 
drawn between the two green cursors (Figure 48b).  If the cursors are moved, the baseline 
will move with them (Figure 48c). 
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Figure 48a. Drawing a base line 
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Figure 48b. Baseline drawn between cursors 
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Figure 48c. Baseline moving with cursors 

 
6. The area of the curve can be calculated by going to Analysis→Calculate Area.  To view 

the calculated area, click Data Analysis, shown in Figure 49.  The user can input the scan 
rate of the experiment to obtain the calculated charge in Coulombs. 
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Figure 49. Calculated peak area and charge 
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Data Analysis – SIS 
1. [Display Cell Data] Data→Analyze Selected (Figure 50) opens the [Data Analysis] 

window (Figure 51). 

Figure 50 Opening [Data analysis] window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 51 [Data analysis] window 
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2. [Data Analysis] Analysis→ Impedance Analysis→ Step Impedance Spectroscopy (Figure 
52) opens the [Step Impedance Calculator] window (Figure 53). 

Figure 52 Opening [Step impedance calculator] 
  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

Figure 53 [Step impedance calculator] 
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3. Select Cell Model allows the user to select the circuit that best represents the device he or 
she is using for the experiments by clicking the image and choosing one of the listed 
options.  In figure 54 the first option is a simple electrochemical cell.  The second and 
third options are batteries.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 54 Selecting a cell model 
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4. Figure 55 shows the third option (battery) selected.  Descriptions for the variables are 
listed in the glossary in the “SIS Impedance Calculator” chart. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Figure 55 Battery cell model 
 

 
 

  



EZware Operating Manual 
 
 

  94 
NuVant Systems Inc.  Release - 4.0 
 

Filters 
1. Data filters can be accessed by going to [Display Cell Data] →Filters→Square, Median, 

Butterworth (Figure 56).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 56. Filter selection 

2. [Square filter] is shown in figure 57.  In this window, the user can select to apply the 
fil ter to the current, potential, or both.  Window Size is the number of points that are used 
to average.  The total number of data points remains the same after filtering.  For 
example, if the Window Size is 2, point 2 will be replaced with the average value of 
points 1 and 2, point 3 will be replaced with the average value of points 2 and 3, and so 
on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 57. [Square filter] 
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3. [Median filter] is shown in figure 58.  In this window, the user can select to apply the 
filter to the current, potential, or both.  Window Size is the number of points that are used 
to find the median.  The total number of data points remains the same after filtering.  For 
example, if the Window Size is 3, point 2 will be replaced with the median value of 
points 1, 2 and 3.  

 
 
 
 
 
 
 
 
 
 
 
 

Figure 58. [Median filter] 
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4. [Butterworth filter] is shown in figure 59.  In this window, the user can select to apply the 
filter to the current, potential, or both.  Maximum Frequency is the suggested maximum 
value for Cutoff Frequency.  Cutoff Frequency is the value at which to apply a low pass 
filter. Only the frequency below the Cutoff Frequency will be allowed to pass.  Any value 
above the Cutoff Frequency will be blocked.  The Filter Order applies to how steep the 
cutoff transfer function will be. The higher order leads to better frequency resolution, but 
might result in larger ripples in the passband.  For more information, visit:  
 
http://zone.ni.com/reference/en-XX/help/371361J-01/lvanlsconcepts/lvac_butterworth_filters/  

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 59. [Butterworth filter] 
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Overlaying Data 
 

1. If  the user has already selected a section of data from [Display Cell Data] to analyze, 
another set of data can be selected from the window to overlay on top of the first.  To do 
this, return to [Display Cell Data] and select Last Run Data, located on the top left of the 
window.  This will redisplay all of the originally collected data.  In Figure 60, the third 
anodic scan  is selected.    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 60. Second anodic scan chosen for data overlay 

 
2. Once the data is selected, select Crop to Cursors to display only the desired data 

window.  To overlay the data, go to Data→Overlay Data.  Once selected, [Analyze Data] 
will now display two data sets, the original data set as a black line and the overlaid 
(second) data set as a green line. 
 

 
3. By going to Analysis→Subtract Overlaid, the user can subtract the overlaid green data 

from the original black data and analyze the new data as desired. 
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Data Analysis – Tafel Plot 
 

1. Corrosion data can be analyzed in [Display Cell Data].  In this window, select 
Data→Analyze Selected (Fig. 61). 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 61. Corrosion data analysis 
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2. [Analyze Data] will now be displayed.  Go to Analysis→Tafel Plot, to view the collected 
data as a Tafel Plot (Fig. 62). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 62. Converting corrosion data (top image) to Tafel Plot (bottom image) 
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3. By going to Plots→Plot Cursors→Cursor Along Plot, and clicking the mouse while 
holding CTRL, four cursors can be placed on the data (two green and two yellow), shown 
in Figure 63. 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 63. Placement of cursors for corrosion analysis 
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4. To draw two straight lines, one between each pair of cursors, go to Analysis→Corrosion 
Analysis (Fig. 64).  The lines will move with movement of the cursors. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 64. Straight lines drawn between cursors for corrosion analysis 
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5. The corrosion analysis results can be viewed by going to Data Analysis at the top of the 
graph window (Fig. 65).  The user can enter the Surface area (cm2), Equivalent weight (g) 
and Density (g/cm2) in the Electrode Properties input boxes. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 65. Corrosion analysis calculations 
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TROUBLESHOOTING INFORMATION 
 

Information adapted from: Bard, A. J.; Faulkner, L. R. Electrochemical Methods: Fundamentals 
and Applications; 2nd ed.; John Wiley & Sons, Inc.: New Jersey, 2001, p 654-656. 
 
If you are experiencing difficulties with your electrochemical experiment, check the following 
troubleshooting tips before submitting a customer service request: 
 
Software 
 

1. Make sure that both the LabVIEW and NiDAQ software are up to date. 
2. Check that you are using the most up to date version of the appropriate EZware software.  

If you are unsure, the most recent versions of all software can be found at 
http://nuvant.com/download-software/software/  

 
Instrument/Experimental 
 

1. Ensure that the electrodes are properly connected to the instrument and the 
electrochemical system.  If using a typical three electrode system, the working electrode 
sense lead (if provided) is shorted to the working electrode lead.  

2. Check that the potential and current ranges fall within the instrument capabilities.  In the 
recipe file, make sure that the correct current range has been selected for the experiment.  
You will not get accurate data if your current output is greater than the instrument 
specifications. 

3. If you are seeing an atypical data plot, first check that the instrument is operating 
correctly by replacing your electrochemical system with a resistor.  Connect the working 
electrode and working electrode sense leads to one side of the resistor, and the reference 
electrode and counter electrode leads to the other side of the resistor.  Run your recipe 
using this setup.  If the resulting data follows the correct voltage parameters and has a 
current output proportional to your resistor value, the software and instrument are 
working correctly.  The problem is due to the electrochemical cell.  If you do not see the 
correct data, contact technical support via the Customer Support Form at 
http://nuvant.com/contact-us/. 

4. If the resistor data is correct, the electrochemical cell can be checked.  Make sure that all 
the electrodes are undamaged (wire leads are in contact with the electrode surface). If a 
wet electrochemical cell is being used, make sure that the cell was purged with inert gas 
prior to running the experiment and that the purge is not in the solution while running the 
experiment (purge can be maintained above the line of your solution). 

5. Connect the counter and reference electrode leads to the counter electrode (the reference 
electrode will not be connected to any electrode leads) and run the experiment.  If the 
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resulting data is that of the expected data plot with a potential shift, there is a problem 
with the reference electrode.  Check that there are no air bubbles around or in the 
reference electrode, specifically at the tip of the electrode. Try an alternate electrode if 
the problem still occurs.  If the resulting data does not look like the expected data plot 
with the reference electrode bypassed, there is a problem with either the counter or 
working electrodes.  The working electrode should be polished and cleaned. 

 
If these suggestions do not solve the problem you are experiencing, contact NuVant Systems at 
http://nuvant.com/contact-us/. 
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APPENDIX 
 

Instrument specifications for instruments purchased prior to October 1, 2013. Step Impedance 
Spectroscopy only available for instruments purchased after October 1, 2013. 

EZstat-Pro 

 

Cell Control

Compliance Voltage ±25 V

Max Output Current ±1 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.2 V/µs

Bandwidth 8 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±10 V)

Applied Potential Resolution 0.3 mV

Applied Potential Accuracy < 0.04% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A)

Best Applied Current Resolution 3 nA, 0.003% of FSR

Applied Current Accuracy 0.03% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pF

Maximum Update Rate 4 µs

Maximum Scan Rate 100 V/s

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range

External Control 1 AO, 1 AI, 2 DO

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging

Resolution 3 µV, 300 µV  (0.006%, 0.003% of FSR)

Accuracy 0.08 or 0.03% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A )

Potentiostat Min to Max 3 nA to 1 A

 Best Resolution

Galvanostat: 3 nA (0.003% of FSR)                                                        

Potentiostat: 610 pA - 340 µA (0.06 - 0.003% of FSR In 

Order of Range)

Accuracy
Galvanostat: 0.03% of FSR;                                                

Potentiostat: 0.3 - 0.03% of FSR Depending on Range

Data Acquisition

Acquisition Time 8 µs

Acquisition Speed 125 kS/second

DAC Resolution 16 bits

FSR: Full Scale Range
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EZstat-Pro LC 
Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±10 mA 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±10 V) 

Applied Potential Resolution 0.3 mV 

Applied Potential Accuracy < 0.04% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA)    

Best Applied Current Resolution 40 pA, 0.004% of FSR 

Applied Current Accuracy 0.04% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 4 µs 

Maximum Scan Rate 100 V/s 

IR Compensation None, Low Current Device 

External Control 1 AO, 1 AI, 2 DO 

  
Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging 

Resolution 3 µV, 300 µV  (0.006%, 0.003% of Full Scale Range) 

Accuracy 0.08 or 0.03% of Full Scale Range   

  
Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA)                                                        

Potentiostat: 4 (±1 µA, ±10 µA, ±100 µA, ±10 mA) 

Potentiostat Min to Max 3 nA to 10 mA 

 Best Resolution 
Galvanostat: 40 pA (0.004% of Full Scale Range)                                                        

Potentiostat: 40 pA (0.004% of Full Scale Range) 

3 σ Coverage Factor Accuracy 
Galvanostat: 0.04% of Full Scale Range                                   

Potentiostat: 0.04% of Full Scale Range 

  
Data Acquisition   

Acquisition Time 8 µs 

Acquisition Speed 125 kS/second 

DAC Resolution 16 bits 
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EZstat-Basic  
 

 

Cell Control

Compliance Voltage ±25 V

Max Output Current ±1 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.2 V/µs

Bandwidth 8 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±2.5 V)

Applied Potential Resolution 7 mV

Applied Potential Accuracy < 0.4% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A)

Best Applied Current Resolution 60 nA, 0.06% of FSR

Applied Current Accuracy 0.35% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pF

Maximum Update Rate 100 ms

Maximum Scan Rate 1 V/s

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range

External Control None

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V)

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR)

Accuracy 0.15% or 0.08% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, )

Potentiostat Min to Max 15 nA to 1 A

Best Resolution

Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range)

Accuracy
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range

Data Acquisition

Acquisition Time 100 µs

Acquisition Speed 10,000 samples/second

DAC Resolution 14 bit

FSR: Full Scale Range
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EZstat-Basic +5 
Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (0 ÷ 5 V) 

Applied Potential Resolution 1.2 mV 

Applied Potential Accuracy < 0.4% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A) 

Best Applied Current Resolution 60 nA, 0.06% of FSR 

Applied Current Accuracy 0.35% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 100 ms 

Maximum Scan Rate 0.1 V/s 

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range 

External Control None 

  
Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) 

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR) 

Accuracy 0.15% or 0.08% of FSR 

  
Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, ) 

Potentiostat Min to Max 15 nA to 1 A 

Best Resolution 
Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range) 

Accuracy 
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range 

  
Data Acquisition   

Acquisition Time 100 µs 

Acquisition Speed 10,000 samples/second 

DAC Resolution 14 bit 

FSR: Full Scale Range 
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EZstat-Basic LC 
Cell Control   

Compliance Voltage ±25 V 

Max Output Current ±1 A 

Rise Time 45 µs for 1 Ohm load (0%-100% signal)  

Slew Rate 0.2 V/µs 

Bandwidth 8 kHz (-3 dB, 1 Ohm load) 

Applied DC Potential Ranges 1 (±2.5 V) 

Applied Potential Resolution 1.2 mV 

Applied Potential Accuracy < 0.4% FSR 

Current Autoranging In Galvanostat Mode 

Applied DC Current Ranges 4  (±1 µA, ±10 µA, ±100 µA, ±10 mA) 

Best Applied Current Resolution 60 nA, 0.06% of FSR 

Applied Current Accuracy 0.35% of FSR 

Input Bias Current 500 pA 

Input Impedance 250 GΩ parallel to 3 pf 

Maximum Update Rate 100 ms 

Maximum Scan Rate 0.1 V/s 

IR Compensation NA 

External Control None 

  
Potential Measurement   

Measured DC Potential Ranges 2 (±50 mV, ±10 V) 

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR) 

Accuracy 0.15% or 0.08% of FSR 

  
Current Measurement   

Measured Current Ranges 
Galvanostat: 4 (±1 µA, ±1 µA, ±10 µA, ±10 mA)                                                        

Potentiostat: 4 ((±1 µA, ±1 µA, ±10 µA, ±10 mA ) 

Potentiostat Min to Max 3 nA to 10 mA 

Best Resolution 
Galvanostat: 40 pA (0.01% of FSR)                                                        

Potentiostat: 40 pA (0.24 - 0.013 % of FSR In Order of 

Range) 

3 s Coverage Factor Accuracy 
Galvanostat: 0.04% of Full Scale Range                                   

Potentiostat: 0.04% of Full Scale Range 

  
Data Acquisition   

Acquisition Time 100 µs 

Acquisition Speed 10,000 samples/second 

DAC Resolution 14 bit 

 



EZware Operating Manual 
 
 

  110 
NuVant Systems Inc.  Release - 4.0 
 

Multichannel Potentiostat 
EZstat-Basic 8 

Cell Control

Compliance Voltage ±15 V

Max Output Current ±1 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.2 V/µs

Bandwidth 8 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±2.5 V)

Applied Potential Resolution 7 mV

Applied Potential Accuracy < 0.4% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 µA, ±1 mA, ±100 mA, ±1 A)

Best Applied Current Resolution 60 nA, 0.06% of FSR

Applied Current Accuracy 0.35% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pF

Maximum Update Rate 100 ms

Maximum Scan Rate 1 V/s

IR Compensation Manual, Potentiostat Mode 10 mA - 1 A Range

External Control None

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V)

Resolution 12 µV, 1.2 mV  (0.03%, 0.01% of FSR)

Accuracy 0.15% or 0.08% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 µA, ±1 mA, ±100 mA, ±1 A)                                                        

Potentiostat: 4 (±1 µA, ±100 µA, ±10 mA, ±1 A, )

Potentiostat Min to Max 15 nA to 1 A

Best Resolution

Galvanostat: 12 nA (0.01% of FSR)                                                        

Potentiostat: 2.4 nA - 0.13 mA (0.24 - 0.013 % of FSR In 

Order of Range)

Accuracy
Galvanostat: 0.08% of FSR;                                                

Potentiostat: 0.08 - 1.5% of FSR Depending on Range

Data Acquisition

Acquisition Time 100 µs

Acquisition Speed 10,000 samples/second

DAC Resolution 14 bit

FSR: Full Scale Range
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Powerstat-05 

 
 

 
 

Cell Control

Compliance Voltage USA ±25 V, IEC ±15 V

Max Output Current ±5 A

Rise Time 45 µs for 1 Ohm load (0%-100% signal) 

Slew Rate 0.8 V/µs

Bandwidth 6 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±10 V)

Applied Potential Resolution 0.3 mV

Applied Potential Accuracy < 0.04% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 mA, ±1 A, ±3 A, ±5 A)

Best Applied Current Resolution 3 µA, 0.003% of FSR

Applied Current Accuracy 0.03% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ parallel to 3 pf

Maximum Update Rate 4 µs

Maximum Scan Rate 100 V/s

IR Compensation Manual, Potentiostat and Galvanostat Modes, All Ranges

External Control 1 AO, 1 AI, 2 DO

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging

Resolution 3µV, 300µV  (0.006%, 0.003% of FSR)

Accuracy 0.08 or 0.03% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)                                                        

Potentiostat: 4 (±100 mA, ±1 A, ±3 A, ±5 A)  

Potentiostat Min to Max 1 mA to 5 A

 Best Resolution
Galvanostat: 3 µA (0.003% of FSR)                                                        

Potentiostat: 3 µA (0.003% of FSR)

Accuracy
Galvanostat: 0.03% of FSR                                       

Potentiostat: 0.03% of FSR

Data Acquisition

Acquisition Time 8 µs

Acquisition Speed 125 kS/second

DAC Resolution 16 bits

FSR: Full Scale Range
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Powerstat-20 

 

Cell Control

Compliance Voltage  ±10 V

Max Output Current ±18 A

Rise Time 60 µs for 0.2 Ohm load (0%-100% signal) 

Slew Rate 0.8 V/µs

Bandwidth 6 kHz (-3 dB, 1 Ohm load)

Applied DC Potential Ranges 1 (±10 V)

Applied Potential Resolution 0.3 mV

Applied Potential Accuracy < 0.04% FSR

Current Autoranging In Galvanostat Mode

Applied DC Current Ranges 4  (±100 mA, ±0.8 A, ±3 A, ±18 A)

 Applied Current Resolution by Range

±100 mA: 15 µA (0.015% of FSR),                                                                                            

±0.8 A: 53 µA (0.0067% of FSR),                                                                           

±3 A: 0.12 mA (0.0039% of FSR),                                                                              

±18 A: 0.56 mA (0.0031% of FSR)

Applied Current Accuracy by Range

±100 mA: 0.10% of FSR,                                                                                  

±0.8 A: 0.053% of FSR,                                                                                  

±3 A: 0.037% of FSR,                                                                                  

±18 A: 0.033% of FSR

Input Bias Current 500 pA

Input Impedance 250 GΩ  parallel to 3 pf

Maximum Update Rate 4 µs

Maximum Scan Rate 100 V/s

IR Compensation Manual, Potentiostat and Galvanostat Modes, All  Ranges

External Control 1 AO, 1 AI, 2 DO

Potential Measurement

Measured DC Potential Ranges 2 (±50 mV, ±10 V) Autoranging

Resolution 3µV, 300µV  (0.006%, 0.003% of FSR)

Accuracy 0.08 or 0.03% of FSR

Current Measurement

Measured Current Ranges
Galvanostat: 4 (±100 mA, ±0.8A, ±3 A, ±18 A)                                                        

Potentiostat: 4 (±100 mA, ±0.8 A, ±3 A, ±18 A)  

Potentiostat Min to Max 1 mA to 18 A

  Resolution by Range

Potentiostat and Galvanostat are the same                                                                     

±100 mA: 15 µA (0.015% of FSR),                                                                                  

±0.8 A: 53 µA (0.0067% of FSR),                                                                              

±3 A: 0.12 mA (0.0039% of FSR),                                                                        

±18 A: 0.56 mA (0.0031% of FSR)

Accuracy

Potentiostat and Galvanostat are the same                                                                     

±100 mA: 0.095% of FSR,                                                                                  

±0.8 A: 0.050% of FSR,                                                                              

±3 A: 0.035% of FSR,                                                                             

±18 A: 0.031% of FSR

Data Acquisition

Acquisition Time 8 µs

Acquisition Speed 125 kS/second

DAC Resolution 16 bits

FSR: Full  Scale Range
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A 

AC main power switch, 35 

AC power input, 34, 35 

AC supply voltage, 27 

accessory cables, 29 

analyze data, 81 

area calculations, 85 

axes, 64 

axes rescaling, 73 

B 

baseline, 82 

battery cycling, 55 

butterworth filter, 93 

C 

calculate area, 78 

cell enable switch, 32 

cell model, 89 

cell ON after measurement, 44, 45, 47, 51, 56, 57 

change axes, 64 

charge, 85 

charging current [A], 55 

charging voltage limit [V], 55 

check for new device, 39 

circuit, 89 

cleaning, 36 

common plots, 64 

computer control, 26 

configure instrument, 39 

contact information, 29 

cooling, 34 

corrosion analysis, 99 

corrosion experiment, 62 

counter electrode, 31, 33 

CPU, 8 

crop data, 78 

crop to cursors, 80, 94 

csv, 76 

current range, 41 

cursor, 81, 97 

cutoff frequency, 93 

cyclic voltammetry, 43, 66 

D 

DAQ, 34, 35 

data analysis, 73, 85, 87 

data collection, 64 

data communication port, 34, 35 

data visualization, 73 

default settings, 43 

density, 99 

differential pulse voltammetry, 56 

digital analog I/O connections, 34 

dimensions, 24 

discharge first, 55 

discharging current [A], 55 

discharging voltage limit [V], 55 

display cell data, 64, 74 

E 

edit single method, 41 

electrical impedance spectroscopy, 59 

electrode connector, 32 

electrode properties, 99 

electrostatic discharge, 27 

environmental conditions, 28 

equivalent weight, 99 

export data, 76 

external input, 32 

external transformer, 34 

EZstat back panel, 33 

EZstat front panel, 30 

F 

filter order, 93 

filters, 91 

final potential [V], 57 

final potential value [V], 45, 47 

first vertex potential [V], 43, 45, 46 

function generator, 8 

G 

galvanostat mode, 43 

general configuration, 41 

general recipe notes, 43 

grounding, 27 
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H 

hardware conventions, 30 

hardware installation, 30 

hold/ramp/step, 51 

I 

impedance analysis, 88 

initial current [A], 58 

initial potential [V], 43, 45, 46, 51, 56, 57 

instrument specifications, 8 

intended use, 25 

L 

LabVIEW Runtime Engine, 37 

last run data, 65, 67 

linear sweep voltammetry, 45, 62 

logging interval [s], 55 

M 

main power switch, 31 

mains power cable, 22, 23 

mains supply, 22, 23 

maintenance, 36 

maximum frequency, 93 

median filter, 92 

model selection, 40 

multi vertex waveform, 46 

N 

NI-DAQmx, 37 

NI-Serial driver, 37 

noise, 34 

normal pulse voltammetry, 57 

number of periods, 46, 47 

number of repetitions, 55 

number of segments, 43 

nuvdt, 76 

O 

overlay data, 94 

P 

potentiostat mode, 43 

PowerStat back panel, 35 

PowerStat front panel, 31 

Powerstat-05E, 21 

pretreatment current [V], 51, 55, 56, 57 

pretreatment potential [V], 43, 45, 46 

pretreatment time [s], 43, 45, 46, 51, 55, 56, 57, 58 

programmable potential waveform, 51 

pulse amplitude [A], 58 

pulse amplitude [V], 56, 57 

pulse increment [V], 56, 57 

pulse period [s], 56, 57 

pulse width [s], 56, 57, 58 

R 

rate/time to next, 51 

reference electrode, 31, 33 

relaxation period [s], 58 

repair, 36 

rescale axes, 73 

restart an experiment, 61 

S 

safety, 26 

sampling interval [ms], 58 

saving data, 73 

second vertex potential [V], 43 

serial number plate, 34, 36 

service, 36 

SIS impedance calculator, 7 

SIS theory, 7 

software installation, 37 

specifications, 8 

square filter, 91 

standby potential [V], 56, 57 

standby value, 51 

startup, 38 

step impedance calculator, 88 

step impedance spectroscopy, 7, 58, 69, 87 

stop an experiment, 61 

subtract overlaid, 94 

surface area, 99 

symbol, 7 

T 

Tafel plot, 96 

technical assistance, 29 

time limit [s], 55 
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timing, 8 

U 

unfiltered data, 65 

USB, 34, 35, 36, 37 

V 

vertexes potential [V], 46 

VRTX value, 51 

W 

waveform, 66, 70 

weight, 24 

window size, 91, 92 

working electrode, 31, 33 

working sense electrode, 31, 33 

 


